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INTRODUCTION 

Once upon a time, in the wild-west days of the eBay marketplace, John Slocum created the first-ever 

auction listing software for his in-laws who were sellers on eBay. He sold his AuctionAssistant software to 

other early adopters who sought a smooth solution for creating eBay listings, then was discovered and 

bought by eBay. At eBay, John and his team created Seller Assistant, upgraded software for eBay listings. 

After a few years, John and team created Blackthorne, a comprehensive desk-top program that offered a 

plethora of features to eBay sellers. 

After eBay announce it would down-size its staff in late 2008, John and his programmers, John Manning and 

Steve Moody, left eBay’s employ in January, 2009, and started working on SixBit, software which would 

expand far beyond the capabilities of their previous creations. SixBit was released to beta testers in 

February, 2010, and then released generally several weeks later. 

SixBit has three levels of use; the Home and Hobby edition for the more casual eBay sellers, the Small 

Business edition for professional eBay sellers and the Enterprise edition for eBay sellers who want more 

advanced tools, the ability to list also to bidstart.com and, eventually, to additional venues. A comparison 

chart of available features of the three levels can be found at 

http://www.sixbitsoftware.com/products.html.  

I didn’t discover Seller Assistant Pro until late in 2002. The learning curve was difficult for me, although its 

eBay discussion forum’s members provided me much assistance. I vowed from the start to create a Quick 

Start Guide once I understood that software – and did so about two months after I first downloaded the 

program. I also became an alpha tester of new revisions. 
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At the New Orleans 2004 eBay Live, John met with a few of us active SAPro users to tell us about the new 

software he started working on – software that became Blackthorne, which was released to users late in 

2005. I was an alpha tester of Blackthorne – and an active eBay seller, so I created a Quick Start Guide for 

that software. Soon after, I began training others on its use by remotely getting on their computers and 

speaking on the phone. 

About the same time John left eBay, I began focusing more on my eBay design business and listed few “real” 

items. For SixBit’s first year and a half of existence, I struggled to learn SixBit. I just didn’t get it; I had 

been the “Blackthorne Lady” for years and since my time to learn had diminished as did the number of my 

eBay listings, it was really tough for me to make the switch. 

I played at SixBit from the beginning and then, in early 2011, one of my long-time Blackthorne clients, Mr. 

E, insisted I teach him SixBit; he couldn’t take his frustration with Blackthorne any longer. (Though eBay 

kept John’s excellent support team of Leslie, Jon and Steve, the in-house development team was not as 

quick or responsive as previously.) Well, I was forced to finally understand SixBit so I could show Mr. E how 

it worked – and darned if I didn’t show him! (Mr. E had called on me monthly for years for help with 

Blackthorne issues. Since switching to SixBit, I’ve received two calls from him regarding SixBit  – and those 

times were Mr. E issues, not issues with SixBit! ) 

Since then, I’ve assisted several other sellers in learning SixBit by remotely getting on their computers to 

show them how to use this wonderful software. I’ve continued to learn SixBit by visiting the discussion 

forums daily and sending in support tickets when I needed help from John & team. I’d been promising to 

write a Quick Start Guide for SixBit since its inception – and here it is. 

This tutorial is geared to eBay sellers and does not address listing on other sites. I use the Enterprise 

Edition, so some features addressed in this guide may not be available if you use one of the other versions of 

SixBit. 

I hope this guide helps you in getting started with SixBit. Please email me if you need me to clarify 

something on these pages; I’ll answer as I can – but I may direct you to ask on the SixBit discussion forum or 

send a support ticket if you ask something I’m not all that well-versed in. 

Thank you, John Slocum, for your support and patience! To John, John & Steve, thank you for answering my 

questions, particularly when I contacted you at inconvenient times or couldn’t formulate my queries 

appropriately. Ruben & Bob, fellow SAPro-ers & Blackthorne-ers, thank you for your encouragement and 

information as I explored this terrific software! 

 I often refer to “the little orange guy” in this guide. He is this icon at the top left of the SixBit 

window: 
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1. DOWNLOAD & SET UP 

If you’ve not yet subscribed to and downloaded SixBit, please use my affiliate link – 

http://www.sixbitsoftware.com/clien ts/aff.php?aff=016 . (I will get a bit of a royalty on this.) 

When you download SixBit, that file will also download SQL Server and some other software needed to run 

the SixBit program. After installation and rebooting your computer, you will run SixBit for the first time. 

When SixBit opens, you’ll first select the sites you list on. You’ll then have to fill out your profile, which is 

the window seen below. Complete with your eBay ID, your mailing address and ship from info, your email 

address and outgoing mail server (all 3 tabs, if appropriate) . If you host your own photos, complete the FTP 

login information section. (I highly recommend uploading your photos to eBay so all will show at the top left 

of the listing pages and Mobile users will see them all.) If you want to add a header or footer message, add 

those. If you charge sales tax to in-state buyers, complete that section.  

 

After completing your profile, you will then be given the option to import your listings data from 

Blackthorne, Turbo Lister, eBay or a CSV file. (If you later want to import data from Blackthorne or Turbo 

Lister, that will delete any data you have in the database, so it’s recommended you only do Blackthorne or 

Turbo Lister imports when you have an empty database. If you do not want to write over your SixBit 

database, export your Blackthorne data, then import it into SixBit after mapping the fields correctly.) The 

time to download those records will vary depending on the amount of records importing and your 

computer’s and internet connection’s speed. When that is done, your main SixBit window will open. I 

recommend you click to view the Get Started video under “To Do List” on the left side of the Dashboard 

window. It’s a 17 minute video which provides a nice intro to SixBit. 
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2. OPTIONS  

When you click on the little orange guy, you’ll see some functions you can perform including making settings 

in the “Options” section. The tabs of your available Options are described here: 

Sites – Select the venues on which you sell. Currently, eBay and BidStart are your choices. 

Reports – Select (and edit) your Packing List, Pick List, Mailing Labels, Inventory Labels and General (your 

default printer) in this area 

Postage – Select your printer and label size for domestic postage. 

Pictures – Apply your choices for Automatic picture Creation and picture Management.  Under the 

Automation tab, I recommend settings similar to this: 

 

You should submit photos to eBay which are not longer than 1600 pixels on their longest side. Do NOT check 

the “During upload…” option so if you mistakenly submit a photo which is shorter than 500 pixels on all 

sides, it will automatically be resized. (This is NOT a good option, as enlarging a photo results in poor 

resolution.) If you display your item pictures in your description wrapper/listing template, set the maximum 

pixel width so your picture(s) will fit into the allotted space.  

If you host your own item photos on your web space, check the “Add item specifics…” box so the pictures 

will refer to the Item Specifics and may be of SEO benefit. To add a watermark to all of your item photos, 

check the “Apply a…” box. Your settings for the watermark are described later in the Photos section of 

Chapter 5 (Sell Items). 

Under the Management tab of this section, I recommend that you choose “SixBit should ensure…”. If you 

host your own photos and want them automatically removed from your site post-sale, check the box to 

“Remove Pictures from…”. 

Backups – You may revise this section as to the number of automatic SixBit database backups you want 

saved, the backup time and location. 
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Performance – If you’re geekier than I, you are probably not even reading this. But, if you are, you may set 

the amount of memory you want SixBit’s SQL Server to use. Of course, having a computer with a good 

amount of memory and a fast processor speed will do you well on SixBit as well as most programs you use. 

Inventory – I recommend you check “Create a purchase record…” so that if you neglect to enter the 

inventory quantity for you item(s), SixBit will automatically create a purchase record and go ahead and list 

the item when you submit it to eBay – barring other issues. Under the “Handling Duplicate Listings” section, 

make the choice best for you as to how SixBit should respond should you attempt to list a duplicate fixed 

price listing on eBay. 

Refreshes – If you ever list or relist items directly on eBay or from other listing software, check the boxes to 

automatically create records and add item specifics to SixBit.  

Under Automatic Updates, you can check the box to change your variation quantities and they aren't 

automatically synched with eBay for running listings. Allocation plans won't perform revise/relists when they 

otherwise would. The reason is that you may have multiple steps of imports or revisions and don't want 

anything to be automatically listed/revised until you're finished. 

Under “Mapping the eBay Custom Label Field”, you can choose to which field the eBay Custom Label should 

be applied – SKU, Notes or Storage Location. (If the Custom Label is one you use as a part number, SKU 

should be your choice.) 

Creating Items – If you want SixBit to automatically create an SKU/part number for items you import or 

create, check the “Automatically generate…” box here. 

You can select your HTML editor choice in this section as well. If you don’t do more than apply simple 

formatting to text, go ahead and select the default WYSIWYG editor. Selecting the “text editor” option 

opens the HTML (description or description wrapper) editor window so you can enter plain text and HTML. 

Being a designer, I, of course, like the third option – and highly recommend Kompozer, a free, open-source 

option that’s quite easy to use and does a good job! (You can download it at 

http://www.kompozer.net/download.php. It downloads a zip file. Just unzip and drag the Kompozer file to 

any place you wish. I did so to the Program Files (x86) folder. Once where you want it, open the Kompozer 

file and find kompozer.exe. Right-click and Send to Desktop (create shortcut) as indicated in image below, 

so you can find Kompozer easily when you want to open it. In this options section, you’ll have to check the 

3rd choice (other editor) and browse to kompozer.exe to select it. (See Description info starting at page 29 

(for WYSIWYG) or 31 (for other).) 
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Creating Orders – Choose what title you want to use when SixBit creates a sales record and how to calculate 

the shipping cost of combined orders in this section. 

Advanced Automation – If you want SixBit to email customers automatically post-sale, check this box. 

General – If you want to be informed on the SixBit Dashboard window of new beta releases, check the box to 

receive them.  
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3. DASHBOARD 

In addition to the “To Do List” on your Dashboard, you can link to “Common Tasks”, “SixBit 

Announcements” and “Recent Discussion Board Topics”. Your eBay stats are also visible on that page.  If you 

have chosen to receive notification of beta releases, that will appear on the left side of this window. A 

screenshot of the Dashboard is below: 
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4. QUICK eBay LISTING 

This guide covers the basics you should know in using SixBit, but if you’re impatient to get started, this 

section will tell you how to create and submit a listing to eBay right away. It will refer to other sections in 

this guide, but you “just want to create a listing”, so… 

 At this point, you won’t have created an Item Template (which holds the default information you’ll use in 

many or all of your listings) nor a Description Wrapper (aka listing template) nor presets (settings for various 

bits of data you may use repeatedly). This is a simple item creation; no variations, no fancy anything – just 

one single item you’re listing. 

CREATE ITEM RECORD 

Select the “Sell Items” tab on the left side of the SixBit window. Click the Plus icon above “Add” 

at the top ribbon bar of your SixBit window (as seen to right). That opens the Item Window. The 

top section of the Item Window is shown below: 

 

• Enter your “Product Title” in the top field. This will be your eBay title of up to 80 characters.  

• Make sure the “Profile” field is the seller ID of the account you’ll be selling this item from. (Your 

main account – or only, if you only have one selling account on eBay – will appear by default in this 

field.) 

• If your item has a “Product ID”, enter to that field. A Product ID is a standardized part number a 

manufacturer may use. It may be an ISBN or UPC code. Just to the right of the Product ID field, you 

may select from a drop-down box whether the Product ID is UPC, ISBN, EAN or MPN. 

• If you’ll be using calculated shipping, or just want to save the “Weight” and “Dimensions” of your 

item (as it will be when packaged for shipping if using this for calculated shipping), enter that data. 

• If you will be collecting sales tax on this item, click on the “Taxable” box to create a checkmark. 

• “Status” will be Under Construction at this point. 

• “Folder” will be Item Repository at this point. 
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• On the “Inventory” field, click on the Add Stock button to enter the quantity of items you are listing 

from this record. You may add the item cost, supplier and purchase date to this info if you want. 

• “Restock At” field – Leave blank for this one. (You’ll use it for records of items of which you sell 

multiples.) 

• You may enter your item’s “Storage Location” in that field. 

• There is a checkbox for “This item has variations”. That will be discussed elsewhere. 

• “SKU” is a part number you create to keep track of your own inventory purposes. 

• “Fixed Price” – If this item will be listed as Fixed Price on eBay, enter the sales amount into this 

field. 

• “Buy It Now Price” – If you will be listing this as an auction item, you may include the Buy It Now 

Price you will sell it at. 

• “Starting Price” – This is the price you will begin your auction listing at. 

• “Reserve Price” – If you’re listing this item as an auction item and will not sell it until bidding meets 

or surpasses a particular price, you may enter your Reserve price in this field. 

• “MSRP” – Manufacturer’s Suggested Retail Price – This is for your information, but may be added to 

your Description Wrapper or Description if desired. 

• “Qty to List” – For this sample listing, 1 (one) is the quantity. In future listings, if you have multiples 

to sell, you’ll enter that quantity into this field. 

• “Notes” – This is a field for your own private notes about the item. 

• “Pictures” – Double-click on the Picture Carousel (box) to open the pictures selection window. When 

the Picture Editor window opens, click on the Floppy Disc icon at the top/left to browse to the 

picture(s) on your computer for this listing. If you want to rearrange the order of those pictures once 

they show in the Picture Editor window, click the title of the picture and drag it to the position you 

want.  

If you’re using the Enterprise Edition, on the left side of the Item Window, you’ll see the “Allocation Plan” 

section; ignore it for now as you’re just listing one item. There’s a little bit on Allocation Plans later in this 

guide. 
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• “eBay Categories” is the next section. Click on the 

arrow on the left side of the eBay Category field to select the 

main category. If it has an arrow following the category 

name, click on that to select the next level category . Repeat 

to select the full category path. When there is no arrow at 

the end of the category path, you’ll have the full path 

selected. 

• “Item Specifics” is your next section to complete. 

Default Item Specifics for the category(ies) you’ve selected 

will appear in white fields, unlike the image to the left. 

Select and complete the Item Specifics’ fields. (Later in this 

guide will be an explanation for creating your own Item 

Specifics. 

• The last section on the left of the Item Window is the “Store Categories” section – IF you have an 

eBay store. You’ll select your Store Categories as you selected the eBay Categories. If your store 

categories do not appear, click on the little green refresh icon at the top right of the Store 

Categories section to refresh them. 

• On the right side of the Item Window 

is the section for “Titles and Description”. 

You’ll see [[ProductTitle]] in the eBay Title 

field. That will pull in the Product Title you 

created above when you submit this listing to 

eBay. 

• If you want to use (and pay for!) a 

subtitle, enter your subtitle into that field. 

• To the right of the Description field is a pencil icon. Click on the pencil to open the “HTML Editor – 

Edit Description Mode” window.  This opens to the mode you chose as described on page 5. If you’re 

using the default SixBit editor, you will type in your description and may use the formatting tools at 

the top of the window to format your description text. (Default formatting tools described on pages 

29 & 30.) When you’ve entered your full description, click the OK button at the bottom right of this 

window. You’ll now see the beginning bit of your description with appropriate HTML in the Item 

Window’s Description field. 
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• “Condition Description” is a field in which you may enter detailed item condition information. If you 

know HTML, you may enter it into this section. 

• “Theme” is a field in which you can choose one of eBay’s themes to frame your description. eBay 

charges for this ‘Listing Designer’ theme.  

• If you wish to have a “Counter” on your listing page so you can see how many visitors it receives, 

select the counter you wish to use. 

• “Lot Size” is number of items within the group of a quantity of one. For example, if you are selling 

one group of pencils for $5, the quantity is one. You may be selling 20 pencils; thus, your lot size is 

20. 

• “I’ll host my own pictures for this item” is a box you check if you are hosting item pictures on your 

own web hosting space. Unless you have a really good reason to host ‘em yourself, do NOT check this 

box, thus letting eBay host your pictures! eBay Picture Service is far better than it used to be, 

allowing for images up to 1600 pixels on one side. Your eBay-hosted pictures will all be visible on 

mobile devices, while only your first photo will be shown on eBay Mobile if you host your own. 

 

• “Description Wrapper” is the next section. If you haven’t yet created any Description Wrappers 

(known as listing or ad templates by most), “None” or “Basic” will be your choice. 

• The “Listing Upgrades” section is one in which you can select features which may benefit your 

listing. See http://pages.ebay.com/help/sell/fees.html#optional for the upgrades’ descriptions and 

fees. 
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• In the “Payments” section, you will select the boxes for the payment 

“Methods” you accept. Under the “Instructions” tab, you may write any 

special instructions you have regarding payments. Under the “Returns” tab, complete as appropriate 

for your return policy. 

• If you accept Best Offers on Fixed Price items, check the “Accept Best Offers on fixed price items” 

box. Checking this box will open to two additional lines in which you can choose to automatically 

accept and decline offers at a certain price. (This automation can save you time from having to 

respond manually to offers made.)  

 

• The final section to complete on the Item Window is the “Shipping” section. At this point, you’ve not 

yet created any shipping presets, so you will complete the Domestic and International tabs for this 

particular item. When you complete this section, if this shipping configuration is one you’ll probably 

use again, click on the icon to the right of the Shipping field name to enter a name for this Shipping 

Preset so you’ll have it available to use again.  

Before saving this item record, you may want to check it. At the right side of the Item Window about 300 

pixels down from the top, click on the “Check Item” button which is shown to the right. First, your item 

pictures will be uploaded to the SixBit database. Then a preview window opens so you can see what your 

description section of the listing will look like plus thumbnails of the item pictures you’ve selected. At the 

top left of this “Check Item” window, you may select your listing format and duration and click on the 

“Check” button to see if you have any errors which need to be fixed prior to submitting the listing to eBay. 

The screenshot below  shows issues which will cause the listing to fail to submit to eBay. Click done to close 

the “Check Item” window. 

 

 

Once all is good to go, click the “Save and Exit” button at the bottom right of the “Item Window”. 
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You may now “Submit” this listing to eBay by clicking on the “Submit” icon in the 

“Sell” section at the top of the “Sell Items” window. Correct your Listing Format 

and Duration in this window. The “Submit” window will pop up. Correct your 

Listing Format and Duration in this window. First, your item pictures will be 

uploaded to eBay or your picture host. Click the “Submit” button to send this 

listing to eBay. 

Your item record will now have moved from the “Under Construction” to “Previously Listed” “Workflow” 

section of “Sell Items”. It will also now appear under “Check Listings” in the “Running” “Workflow”. 

Now – review the rest of this guide so you can use SixBit in the way it was intended! 
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5. SELL ITEMS 

The Sell Items window is the one in which you create item records which you’ll then list to eBay. You may 

create an item from scratch, duplicate an item record, create an item from an Item Template or, indirectly, 

add items from a CSV file.  I recommend after creating your first from-scratch record, you then create an 

Item Template from that first record. Edit the Item Template so it holds only information which will apply 

to most of your future item records. (More on Item Templates in a little bit.) 

CREATE ITEM FROM SCRATCH 

 

On the ribbon at the top of the window, click on the 

plus sign to add your first record from scratch. 

(Henceforth, you will click the tiny arrow below “Add” 

to create a record from an Item Template.) This will 

open the Item Window, in which you’ll enter the 

appropriate data about your item.  

The screenshot to the above right shows the full Item 

Window of the Enterprise edition of SixBit. Each 

section is addressed here: 

 

Top Section 

 

The top, non-scrolling portion of the Item Window is what I call the Master Section as it holds information 

which will be common to the particular item regardless of the site to which you’ll be listing it to. Again, this 

tutorial is all about listing to eBay, so we’ll address this and all sections as appropriate to eBay.  
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First, the text fields in the Master Section: 

 

Product Title – This is a unique title to identify your item. If you’re only listing it on eBay, you may choose 

to enter your eBay title in this space, as the Title field in that section below shows [[ProductTitle]]. (If 

you’ll be listing the item on other site(s), your title may differ between the sites; the Product Title will 

identify the item regardless of its site title.)  

To the right of the Product Title field is a counter which tells you how many characters are in the title as 

you type it in; this is handy to keep your eBay title to 80 characters.  

 

Profile – This is your eBay seller ID name. If you manage more than one selling account, you will want to 

make certain the correct ID is selected in this field. 

 

Product ID – A Product ID is a standardized part number a manufacturer may use. It may be an ISBN or UPC 

code. Just to the right of the Product ID field, you may select from a drop-down box whether the Product ID 

is UPC, ISBN, EAN or MPN. If, for example, you are selling a specific book, you’ll enter its ISBN here, as that 

number identifies that specific book to the public.  

 

SKU – The SKU (stock-keeping unit) is the part number you issue to identify the product for your own 

purposes. A good practice is to have an SKU which makes some sense other than being composed of a mish-

mash of numbers and/or letters. For example, if you sell jewelry, you may create a system such to identify 

the type of piece (R for ring), the metal (G for gold), the gem (V for variety), the manufacturer (XYZ for XYZ 

Company) followed by your date of purchase (112312), resulting in your SKU of RGV-XYZ-112312. 

 

Weight & Dimensions – The weight and dimensions fields will be used by eBay if you choose calculated 

shipping. (Be sure to add the box and packing materials weight to this!) If you use SixBit to create shipping 

labels, SixBit will also use this information. 
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Fixed Price, Buy It Now Price, Starting Price, Reserve Price, MSRP, Qty to List – By entering all the prices 

you may use for eBay and/or other sites, you won’t have to modify these later. For example, if the item 

you’re listing has a manufacturer’s suggested retail price (MSRP) of $29.97 and you will be listed as a Fixed 

Price item now for $25 and you may list it on auction later starting at $9.99 with a Buy It Now Price of 

$24.99, you will enter that information as shown in screenshot above. 

The Qty to List field is for the number of items you have available for sale for this item record. Be aware, if 

you are selling 12 eggs in one listing, that is a quantity of 1 (dozen) unless you’re selling each egg 

separately, which would be a quantity of 12. The 1 dozen eggs is a lot of 12. 

 

Variations – Variations are used in certain categories, such as clothing, for which you have size, color or 

other variations for the same item. When you check the “This item has variations” box, a small “Select 

Variations” window opens with “Size” as the first choice. Click on the sun icon to the right of that field to 

open the “Manage Variations” window as shown at the top of the next page. 

 

 Before checking “This item has variations” box, be sure to add pricing information! 
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Select the eBay category to base the variations for the item you’re listing. (This will likely be a category 

you’ll use again for similar items.) When you’ve selected the category, eBay’s recommended item specifics 

will appear as in image below: 

 

Using the blue button with the right arrow, select and move the first of the variations to the Variations box, 

then choose values in that section as shown here: 

 

 

If you want to use a variation which isn’t in the item specifics list, you’ll have to create a custom item 

specific. See page 26 for information on custom item specifics. For each variation you want to add, please 

repeat the above. (NOTE: eBay allows for 5 variations with  a total of 300 variations. Thus, if you have a pair 

of shoes available in 10 colors and 20 sizes, that would be 200 variations. If you have a t-shirt in 10 colors, 

10 sizes and 10 different ink colors, that would be 1000 variations; you’d have to eliminate 700 of the 

possible combinations to list that item on eBay.) 

 

You will then choose the Variation for which you want to show different pictures. By default, you’ll 

generally see the Variation photo icon next to the Color Variation as in the image above. In the screenshot 

to the right, you’ll see that I’ve selected Pattern as the Variation photo choice:  
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Next, is the SKU, your part number for each Variation combination. SixBit will issue a default (but loooong) 

SKU to each combo, but you can modify the SKU style by clicking on the SKU Builder button. As you can see 

to the right, once I’ve entered my SKU styling, the Sample at the top of the SKU Builder window shows me 

what the SKU will look like. Click the OK button when you’ve set your SKU format/style. 

 

Before clicking the Save button on the “Manage Variations” window, be sure all is correct. Once you’ve 

saved a Variation Set, it cannot be changed. When you do click to Save & Exit, you’ll be asked to name the 

Variation Set you’ve just created. I recommend naming it something which accurately defines the set; Nike 

Men’s Basketball Shoes or Diamond Rings. You’ll likely use a variation set again, even if you have fewer color 

selections for a future item.  

When you then check the box for “This item has variations” on an item, you’ll be asked to enter the custom 

value for the SKU if you’ve opted for that in the SKU Builder:  

 

Once you’ve chosen the Variation Set for an item, a grid of the variation possibilities will appear in the top 

right of your Item Window, where the pricing fields were:  
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In this grid, you may edit the SKU and price of the variations. In the Qty Uncommitted field, you will enter 

the quantity you have available for each particular variation by right-clicking on each line and selecting 

“Manage Inventory” (as shown below). This will open the Purchase History Window. Click on the “Add Stock” 

button to enter your purchase information as seen below: 

   

In this sample, I’m showing that I have a quantity of 10 items for the particular variation combo, that I paid 

$9.98 for each and I purchased from Doe’s Widgets. (You can add suppliers by clicking on the sun icon or 

edit the supplier’s info by clicking on the pencil icon.) 

As seen on the image below, you can note the level at which you want to restock that item and its storage 

location. The bottom half of this window allows you to reconcile your inventory due to shrinkage or other 

reason: 
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To select the picture(s) for each variant, click on the variant row, then double-click the Variations Picture 

Carousel to the right of the grid to open the Picture Editor to select the appropriate picture for the variant. 

If you’ve chosen “color” to be the variation photo, then when you select black, for example, all rows of the 

black item will have that photo applied. (You only need to choose photos for as many colors you have, thus 

if you offer 5 colors, you’ll only have to choose 5 different color rows one time each to populate all 

variation rows with the appropriate photo(s). 

 

Notes – This is a private field for you to make any notes. Will not be seen on eBay or other sites. 

 

Pictures - Enter your photos by double-clicking on the Picture Carousel at the top left of the Item Window. 

This opens the Picture Editor: 

 

You can also right-click on the Picture Carousel to “Manage Pictures” to open a small window to select your 

pictures and to put them in order. 

 If you select more than 12 pictures to use on eBay, SixBit will only submit the first 12, as 

that’s eBay’s limit. 
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You can choose pictures from your computer by clicking on the From File icon and selecting them from the 

appropriate folder. If choosing more than one picture, click on the last picture you want (in the reverse 

order of how they’ll appear on eBay), then hold your Ctrl key down while clicking on each additional 

picture. You can also open a Windows Explorer window of the folder in which your pictures reside; select 

and drag the pictures from the folder into the main area of the Picture Editor window. If you want to 

reorder your pictures, drag one by one from the picture name bar to the space they should occupy.  

You may also add picture URLs of pictures you have on your website or other online location. When you click 

on the “From Web” icon, the below window will open. Type in the URL of your first picture. Each time you 

enter a picture URL, another field will open below to add another: 

 

You may also choose pictures from your camera or scanner which are connected to your PC by clicking on 

the “From Device” icon. 

To edit a picture, double-click its header bar with its file name in it. As shown in the screenshot below, 

there are various things you can use to edit a picture. 
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Using a picture of a pocket watch, here is what each editing tool does: 

This is the original picture (after I’ve double-clicked its header to show it larger): 

 

Pan allows you to drag the picture around if it’s larger than the picture window: 

 

Magnify lets you see a small section enlarged: 
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Select lets you draw a marquee (dotted box) around a section of the picture: 

 

Crop will crop the picture to that which you’ve just drawn a marquee around: 

 

Rotate turns the picture 90 degrees counter-clockwise: 
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Auto Level adjusts the brightness and contrast. (This particular picture already was adjusted, so I made it 

duller in Photoshop for this demonstration. Below is it before and after applying the Auto Level.): 

   

Clicking the small arrow next to Resize opens a slider bar which you can move to make the picture smaller 

or larger. You will see its original pixel width when the resize slider first opens. You can also enter the new 

pixel width you want. (Enlarging pictures in this way will lead to degradation of the picture quality; it’s 

always better to go smaller than larger.) 

       

Delete removes the selected picture from your Picture Editing window.  

Clear All will remove all of your pictures from the item record. 

Zoom In, Zoom Out, View 100% and Fit in Window will show the picture in the available space at 

whichever of those options you choose. 
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Dragging the Brightness and Contrast sliders will darken or lighten your picture and dim or strengthen its 

contrast. 

Click the arrow next to Protect under Watermark to manage your watermarks. As seen in the screenshot 

below, you can type in your eBay ID, apply a font, size, location (on picture) and intensity (strength) of the 

watermark. eBay requires watermarks be 50% or more opaque, so move the intensity slider to the first half 

of the slider: 

 

These images show a portion of the picture without and with the watermark: 

   

Revert (undo) allows you to remove the changes you’ve just made. 
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Left Section 

 

Allocation Plan – Only in the Enterprise Edition will the Allocation Plan section be visible. Choose the 

conditions to automatically relist the item when it ends. You may choose to reduce the price of the fixed 

price listing upon relist. 

Your allocation plan will take effect on eBay on SixBit within 60 seconds. 

You can do this sooner if you choose “Reallocate Now” under the Manage 

icon as seen in this shot:  

There’s an excellent video about Allocations at 

http://www.sixbitsoftware.com/download/videos/UsingAllocationPlans/ 

UsingAllocationPlans.mp4.   

 

eBay Categories – Select your eBay categories by clicking on the arrow at the left of the category field. If 

an arrow appears after the choice, select the next level until there is no arrow at the end of the selection. 

The 10 most recent categories you’ve selected can be found by clicking the down arrow at the end of the 

category field(s). Click on the pencil icon to the right of the category field to enter the category number. 

Click on the globe icon (to the right of the pencil) to see the search results for the selected category on 

eBay.  If you choose a second eBay category, be aware that your listing fees will be doubled. 

 

Item Specifics – When you choose the eBay category, eBay’s default Item Specific fields will appear in this 

section. Please see the Users Guide and search for Item Specifics for information on adding custom and 

private item specifics. Custom Item Specifics are used to add additional Item Specifics fields beyond those 

eBay has designated. When many sellers use the same custom Item Specific field, eBay will eventually add it 

to the default choices. Private Item Specifics are custom data fields which will not be included in the Item 

Specifics section on eBay listings. 
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Private Item Specifics can be quite useful for many sellers and are, in effect, custom fields. For example, a 

book seller may want to create private Item Specifics for the book title, author, publisher, etc. He can then 

include those custom fields in the description or description wrapper (listing template) in pre-determined 

areas. I sell vintage calendar art posters and created these to use in my description field: 

 

My default description for these posters looks like this: 

 

When I’ve filled in these fields, the description looks like this on my listings: 

 

 Think of Item Specifics as keywords in your title as they are searchable as if they are part of 

the title! 
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Store Categories – If you have an eBay Store, you will select your store categories in this section. Use the 

arrow on the left of the store category field to select your store category. The arrow on the right of the 

field will show you the last several store categories you’ve chosen in SixBit. If you had recently added or 

removed store categories on eBay, you can click on the refresh icon at the top right of this section to add or 

remove them in SixBit.  

Right Section 

  

eBay Title – If you want the eBay Title to be the same as your Product Title, leave [[ProductTitle]] in this 

field. If you want a different title on your eBay listing, enter it here.  

To specify an item as private, check the Private box above the title. (This means buyer info will not be 

shown on eBay.) 

 

eBay Subtitle – Add your subtitle into this field. (Be aware: there is an extra charge of 50 ¢ or $1.50 to have 

a subtitle on your listing. You can see the fees here: http://ebay.com/help/sell/fees.html#optional) 

 

 

 

 

 

 

 

 

 

 



29 
 

 

Description (WYSIWYG or Text Editor) – Click on the pencil icon to write your description. If you’ve 

selected the default WYSIWYG or Text editor in Options>Item Creation, that opens the HTML Editor – Edit 

Description Mode window as shown here: 

 

You’ll type in your description into the main blank field. You can add field or custom field names or Snippets 

from the left side of this window by placing your cursor in the main field where you want that to go, then 

double-clicking the field or snippet name. You can also use the editing tools above the main field to format 

your text.  

Here is a chart of what each of those tools means/does: 

 

Opens HTML file if you wish to 

use one for your description. 
 
Font for selected text. 

 

Saves your description prior to 

closing the Description Editor. 
 

Font size of selected text. 

 

Cuts (deletes) highlighted 

item(s) in the editing window.  

Pastes item(s) from your clipboard.  

 

Copies highlighted item(s). 

 
 

Pastes item(s) selected from Word. 

 
Applies bold, italics or 

underlined formatting to 

selected text. 

 

Opens Windows print dialog to print  
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Undo – Redo. Clicking one or 

more times removes or redoes 

changes you’ve made in the 

editing window. 

 

Spell-checks text in WYSIWYG mode 

of editing window. 

 
Applies heading size formatting 

to selected text.  

Applies URL to selected text. (Use 

full URL, not relative.) 

 

Applies highlighting color 

behind selected text.  

Applies color to selected text. 

 

Inserts image into description 

from its internet URL.  

Inserts HTML table per your 

settings. 

 

Inserts special characters, such 

as common fractions and 

copyright symbol as selected 

from chart. 

 Inserts horizontal line which will 

run full width of space. You may 

drag from a corner point to shorten 

this line. 

 

Applies numbering (ordered list) 

or bullets (unordered list) to 

selected lines of text. (This will 

indent the text a bit as well.) 

 Aligns selected text to left, center 

or right. (Will align left by default.) 

Outdents previously indented 

text / indents selected text.  

Puts a line to strike through 

selected text. 

 

Applies superscript (raised, 

smaller) or subscript (lowered, 

smaller) formatting to selected 

text. 

 

WYSIWYG (What You See Is What 

You Get) design mode in editing 

window. 

 

HTML mode in editing window. 

(Do not fiddle with this unless 

you KNOW HTML.) 

 To right of HTML mode icon will be 

HTML section tags used in the 

selected area of the description. (I 

cannot figure any need for this!) 
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You may drag any of the fields in this section into the design mode of 

the editing window. 

For example, if you wish to show the MSRP in the description, you may 

have something like this: 

Manufacturer’s Suggested Retail Price: 

Add a space following the colon, then drag the MSRP field, to see this 

Manufacturer’s Suggested Retail Price: [[MSRP]] 

If the price you have in the MSRP field is $99.99, when in preview or on 

eBay, you’ll see: 

Manufacturer’s Suggested Retail Price: $99.99 

 

Snippets are bits of text and/or images you may use repeatedly in your 

descriptions or wrappers so you don’t have to create that bit time after 

time. Do a search on “Adding Snippets” in the SixBit User Guide for 

additional information. 

 

In the HTML Editor are tabs for Edit and Preview. You may edit in the 

WYSIWYG or HTML mode, then can see a preview of your description 

under that tab.  

 

Description (Other Editor) – Click on the pencil icon to the right of the “Description” field to open your 

chosen other editor. In this guide, I am using Kompozer, so when I click on the pencil icon, my Kompozer 

window opens. (In Chapter 6, MORE HANDY INFO, I have a section on using Kompozer with SixBit.) Kompozer 

opens to the normal design window. Type in your text, apply formatting from the Format menu, add images, 

tables, etc. as per Kompozer’s standard methods. Save and Exit. (You have to go to File>Exit as if you click 

the X to close, Kompozer may reopen immediately.) You’ll now see in the SixBit Description field the start 

of your description text and code. Kompozer adds in some beginning and ending HTML tags which are 

unnecessary for the description, but eBay will ignore this, so you should as well. 
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Condition Description  – “Condition Description” is a field in which you may enter detailed item condition 

information. If you know HTML, you may enter it into this section. 

 

Theme – For a small fee, you can use one of these eBay themes to frame your description area in the 

listing. 

Counter – Choose a visitor counter to add to your listing page if you wish. 

Lot Size – “Lot Size” is number of items within the group of a quantity of one. For example, if you are 

selling one group of pencils for $5, the quantity is one. You may be selling 20 pencils; thus, your lot size is 

20. 

I’ll host my own pictures for this item – Check this box if you’re using your own site rather than eBay for the 

item photos. (If you want all of your photos to appear in the top left area of the listing page and to be 

readily seen on eBay Mobile, upload them to eBay, not to your own hosting site.) 

Description Wrapper – Select the Description Wrapper (Listing Template) to use for this item. Click on the 

pencil icon to edit the Description Wrapper. (Doing so will change the wrapper for future use as well – this is 

something that should be very rarely done.) Click on the Manage Description Wrapper (to the right of the 

pencil) to add, edit, delete or rename Description Wrappers. 

Creating Description Wrappers is a big topic all on its own. On page 43 is some info for creating a simple 

custom description wrapper. See the SixBit User Guide for further information.  

  

Listing Upgrades – Select the upgrades you want here. (See http://ebay.com/help/sell/fees.html#optional 

for more info on these.)  
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Payments – You can create and select your payments information in this section. Once you manually choose 

your payment methods accepted, you can click on the circle icon to the right of the pencil to save it under a 

name you designate. If you have any specific payment instructions you want to add, enter that under the 

instructions tab. You must choose whether you accept returns under the Returns tab. If you accept returns, 

please complete all the choices which appear and enter additional info in the “Enter your return policy 

here” field as needed. 

 

Accept Best Offers on fixed priced items – If you will entertain offers on your fixed price item, check this 

box. That opens two more lines which allow you to automatically accept or decline offers more or less than 

the amounts you enter. If, for example, you are listing an item at the fixed price of $100 and will sell it for 

$80 or more, you may want to check the boxes to auto accept and auto decline and enter $80 in each. This 

way, if a shopper offers less than the $80, you won’t have to bother to respond as eBay will do so for you. 
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Shipping  – You can create and select your shipping information in this section. Once you manually choose 

your shipping plan, you can click on the circle icon to the right of the pencil to save it under a name you 

designate. You can click on the circle icon to the right of the pencil to save your manual choices under a 

name you designate. 

 If you offer free domestic shipping, the first service you select will be free to the buyer. It’s a 

good practice to offer additional services. For example, if that first service is “Economy Shipping”, which 

may be parcel post or media mail, you may want to offer the second choice as Priority Mail and a third of 

Express Mail. This gives your shoppers a choice – and, eBay will not collect fees on the shipping charge from 

you if another shipping option is selected when your first option is free. 

Be sure in the shipping section to also select your handling time and package size – and to complete the 

International tab if your shipping plan offers shipping to international shoppers. 

  

Check Item  – Above the Titles and Description area is a button to Check Item. Click on this to preview what 

your listing will look like. First, SixBit will upload your photos then the preview will open. 

When your info is entered, click the Save and Exit button at the bottom right of the window. 
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SUBMIT 

To submit your item(s) to eBay, make sure it/they are selected in 

the grid, then click on the Submit button in the Sell section of the 

ribbon as shown to right. That opens the Submit button. You will 

only want to submit one copy, otherwise you’ll be creating 

duplicate listings, which are not allowed by eBay. Select the Listing 

Format for the item(s) you’re submitting. (You cannot submit 

auctions and fixed price items together.) Choose the listing 

duration. 

If you wish to schedule your item(s) to start at a specific 

time/day and at designated intervals, click the “Schedule 

Listings” box to enter that information.  Check the “Force order 

of submission” box to list in the same order as selected. This 

option will likely take a bit longer to submit than if unchecked. 

(Image to left.) 
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ITEM TEMPLATES 

An item template is a default record which can be used to create new listings. Your item template(s) may 

include info such as listing upgrades, your payment info and a commonly-used shipping preset. It may 

include your description wrapper, categories, etc. Any of this info may be edited in the listing record you 

create from the item template. 

If you import your listing information from a CSV (flat) file, applying an item template is a good idea; you 

won’t have to later add default info to the imported records. 

You may create an item template in one of two ways: from an item record or through the Manage Item 

Templates function. From an item record, select the record you wish to use as an item template, right-click 

it and “Save as Template” as shown to right. 

To create an item template thru Manage Item Templates, click on the small arrow as shown in the image 

below. That opens the Manage Item Templates window. Click the “New” button to open the Item Template 

window. (This window looks the same as the usual item entry window described in the previous section, 

Create Items from Scratch.) Enter and select default info as appropriate. Save under a name of your 

choosing. 

 

CREATE ITEM FROM ITEM TEMPLATE 

To create a new item from an item template, click on the small arrow under “Add” as seen in the image to 

the right. Click on the name of the item template you want as the base for your new item record. 

This opens the item entry window. You will enter all appropriate info into the various fields – and may edit 

any of the item template’s default information. 
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4. CHECK LISTINGS 

The Check Listings section holds all records of listings (items) which you’ve submitted to eBay (or have 

scheduled to list in the future). The Work Flow view allows you to choose from listings you have scheduled 

to list on eBay, the listings you have currently running or past/completed listings. 

Listings in “Scheduled” may be revised or rescheduled prior to the scheduled submission time as can those 

in “Running”. If you click on the eBay number (EcommerceID) of a listing in the Running grid, that will open 

your default browser to its listing on eBay.  

5. SHIP ORDERS 

The workflow of records after an item sells is “Awaiting Payment”, “In Process” and “Fulfilled”. You will 

probably work mostly with records “In Process” as items which have been paid for but not yet shipped will 

be in that section.  This chapter describes my process for handling an item which is “In Process”. (As always, 

if you want more information, please refer to the SixBit User Guide and/or post a question to the SixBit 

discussion forum.) 

I select the record to process in the grid, then click on the 

“Print Postage / Carrier Labels” icon as shown to the right. In 

the window which opens, I select USPS as the Carrier, then 

choose the shipping type and class and add in the weight and 

measurements if needed as shown below. 

 

Under the Services tab, I select “Delivery Confirmation”. If I want to insure the package, under the Postage 

tab, I click the box to “Purchase insurance…”. I also like to print a packing list when I print the postage 

label, so I check the box to do so. Since I’d set it up to use Express 1 postage when I made my first sale 

using SixBit, SixBit knows to print postage from that. If I don’t have enough money left in my Express 1 

account for postage, a window pops up to allow me to add funds into that account. (By the way, if you sell 

from multiple accounts but want to use one account for Express 1, make sure the profile for each of your 

eBay accounts in SixBit uses the same email address.) 
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In the SixBit User Guide, search on Setting up Express 1 if you want to use that for your USPS Priority or 

Express Mail shipping labels. Search on Setting up Endicia if you want to use that for.  

My understanding of (and experience with) Express 1 postage is that Express 1 has a July to July contract 

with USPS, so when USPS raises rates in January, we’re not getting raised rates thru our SixBit Express 1 

accounts for several months! I’ve been very pleased with this service! 

6. MORE HANDY INFO 

WORKFLOW 

On the left side of the main SixBit window, you will see Workflow, Repository and Views for “Sell Items”. 

“Workflow” shows the status of the item, whether under construction or running or completed among 

others, depending on the mode you’re viewing. You may create sub-statuses under any of the default 

statuses and drag records into that sub-status. 

REPOSITORY 

The repository is an item folder. You may create additional folders to store item records in. For example, if 

you have items you want to list on Mondays, you may create a “Monday” folder and batch edit the folder on 

the records you want in that folder to the “Monday” folder. 

VIEWS 

Views show the results of various searches in all three modes of SixBit (Sell Items, Check Listings and Ship 

Orders). SixBit includes some default views, but you may create additional ones by clicking on the Advanced 

Search link, setting your search restrictions, then saving that search for current and future use. (Look up 

Searches and Saved Views in the SixBit User Guide to see how to create, edit, save and delete Advanced 

Searches. 
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GRIDS 

The largest section of the main SixBit window when you’re in “Sell Items”, “Check Listings” or “Ship Orders” 

is the grid section which shows you all records of the mode you’re in; “Workflow”, “Repository” or “Views”. 

There are two grid layouts you can choose from – Grid View and Simple Grid View. There are two icons a bit 

above and on the right of the grid section - .  

This is the Grid View: 

 

This is the Simple Grid View: 

 

You can hide or show grid columns by right clicking the grid header and checking or unchecking the column 

names. You may set up and save particular grid layouts of columns you want to see. For more info on this, 

please search for “Saving Grid Layouts” in the SixBit User Guide. 
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FIND/SORT 

 

If you wish to find records which meet a particular criteria, such as a word in the title, the number of 

quantity you have listed, an SKU number containing this or that, you may enter that just under the title bar 

of the grid. In the above screenshot, I’ve entered the word test while sitting in the Running Workflow of 

Listings. All currently running items which have the word test in the title show up in the grid below. 

 If you want to sort the records showing in the grid, such as the SKU, click on 

the header bar on the words “First SKU” to sort that column in alphabetical 

order. By clicking on the same header again, the sort will be in reverse (Z to A 

to 9 to 0) order. If you want to do a sub-sort by a secondary column, first sort 

your main column, then hold the shift key down while clicking on the second 

column. In the screenshot to the right, I first sorted by Fixed Price, then on 

Quantity Listed. 

ADVANCED SEARCH 

Look up Searches and Saved Views in the SixBit User Guide to see how to create, edit, save and delete 

Advanced Searches. 

BULK EDIT/BATCH CHANGE 

In the Sell Items mode, you may click on the Edit icon as seen to the left to either bulk 

edit or batch change specific data on a one or more item records at one time. “Bulk Edit” 

opens one item record. You will see (Multiple Values) entered into those fields which have 

different data among the selected records. You may replace (Multiple Values) or any other 

field with the data you want to change all the selected records to.  

“Batch Change” opens a small window which allows you to change one or more fields of all selected records. 

You may also save this batch change configuration – and will see it under “Views”. 
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PACKING LIST EDITING 

 To edit a packing list, go to Options under the little orange guy, 

to Reports. In this sample, I show how to modify the landscape 

packing list. 

• Select the Packing List you want to edit. (A4 Landscape as shown to right.)  

• Click on the gold icon to the right of the packing list selection field. 

• Select the Packing List (A4 Landscape, for this demo) in the window that pops up, then click on the 

Edit button. This opens the Telerik Report Designer to the Design View.  

• To change the pale blue background at the top of the report, click in a blank spot on that light blue 

section so that it’s highlighted by the box as shown below. 

 

• At the bottom right of the report window, you’ll see the “Properties”. Click on the arrow to the left 

of the word “Style” to expand the styling options.  You’ll see this right under “Style”: 

 

• Click on the small blue box to the left of the numbers to make an arrow appear after the numbers, 

then click on that arrow to open the color selector. You’ll see 3 tabs – “Custom”, “Web” and 

“System”. Click on the color you want from any of those tabs and it will change the background 

color. 

• To change the font, text size and color, click on the Ship to: text as shown below. 

 

• Under Style in Properties, you’ll see the Color and Font properties. Click on the current color to 

make the arrow appear, then click on that arrow to open the color selector as described above. 

• To change the font name, size and more, click on the arrow to the left of the word “Font”. Click in 

the property of each of your choices to change them. In this sample, I made Bold False, Italic True, 

Name Times New Roman and Size 12pt so that in the design view, what was just shown above, now 

looks like this:  
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• To change the text, “This is not a bill – No payment is due”, click on it in the design view: 

 

• In Value under Properties, delete the text and type in what you want to change it to. (This can be 

then edited for color and font as described above. 

• If, for example, you’ve changed that “This is not a bill…” text to something longer, you will either 

have to make its font smaller or Increase its space. By holding your cursor over the tiny blue squares 

as shown in the image above a few lines, you’ll see a cursor with arrows at both ends. You can click 

and drag the tiny blue square to resize its “binding box”. 

• Now, perhaps you want to remove the Sale ID from below the item title. You’ll have to close the 

Telerik Report Designer and select the SubReport of the Packing List you’re editing: 

 

• As seen in composite screenshot to the 

right, I show [=Fields. In the design view. 

Notice the Value in Properties is 

=Fields.SaleID, which tells us that this is the 

Sale ID selected in the design view. Just to 

the left of [=Fields. Is the text Sale ID:. 

Delete both of these fields.  

• Close this report window and click to Edit “Packing List – A4 Landscape”. Click on the Preview icon 

near the top left of the Report Designer and you’ll see that Sale ID no longer appears under the title 

of the item and that the fields to the right of where the Sale ID fields have been have moved to the 

left. 

• Currently, in the preview in the Report Designer, you’ll see a number of blocks of red text referring 

to various errors. I’m trying to find out how to get rid of these errors because when I create a 

packing list for a sale  I’ve made, it prints out as expected. (So – just ignore the errors for now.) 
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DESCRIPTION WRAPPERS 

You may create a customized description wrapper in SixBit. If you have the HTML (source) code for a custom 

description wrapper someone has created for you, you’ll have to change your HTML editor option to Text 

Editor in the Creating Items option as described on page 5. You may also create a wrapper directly thru 

SixBit yourself with Dreamweaver, Kompozer or other similar program. Instructions for creating a simple 

description wrapper with Kompozer follows. (I’ve chosen to use Kompozer for this as it’s free and easily 

available. It’s a bit more complicated than using SixBit’s default WYSIWYG editor, but with a bit of practice, 

I’ll bet you find it comfy to use after a short while.) 

USING KOMPOZER WITH SIXBIT (Create Simple Description Wrapper) 

In this section, I describe creating a simple description 

wrapper (listing template) using Kompozer thru SixBit. (I’ve 

already set Kompozer to be my HTML editor in SixBit.) 

Under the little orange guy, go to Manage> Description 

Wrappers. Click the New button and name your wrapper such 

as in the image to the right. Click OK. 

Select your Wrapper in the list on the left side of the “Manage Description Wrappers” window and click the 

Edit button to open Kompozer. 

Kompozer opens to “Normal”, which is the WYSIWYG window. The image below shows what I typed in plus a 

table of 2 rows by 3 columns: 

 

Now, for the formatting: 

Highlight [[Title]] and apply formatting by going to the Format menu and selecting your choices: 
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Highlight [[Description]] and apply formatting under the Format menu. 

No formatting is needed for [[PictureGallery]] or any of the [[PictureX]] tags. 

I had created the table by clicking on the Table icon and highlighting 3 x 2 cells as shown to the right: 

To format the table, click on the table then right-click to “Table Cell Properties”. Click on the “Table” tab 

and apply formatting as shown in image below: 

 

Now, go back to create a frame for the template. Put your cursor befor [[Title]] and click the Enter key on 

your keyboard once. Put your cursor in the line without text above [[Title]]. Create a one-cell table and 

apply these properties similar to how you applied the table formatting above: 
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You’ll now see this: 

 

 

Highlight [[Title]] and drag your mouse down below the yellow table. Right-click to Cut, then put your 

cursor inside the table cell with the gray frame and Paste what you’ve just cut. You’ll now see this: 

 

I want a bit more space between [[PictureGallery]] and the yellow table, so I click after [[PictureGallery]] 

and click the Enter key on my keyboard. 

Now, I’m going to add my terms of service into the yellow table. I type the appropriate info into each of the 

yellow cells to get this: 
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Formatting is needed, so apply formatting to the text as described earlier. Notice the columns are different 

widths and that all text in the second row doesn’t start at the same horizontal line, so those cells should be 

formatted for vertical alignment. To do so, highlight the second row of cells and right-click to “Table Cell 

Properties”. (You can select a row, column or all cells to apply text formatting to a group of cells at once as 

well.) After selecting the second row, I applied these properties to the cells: 

 

I then selected the 3 cells in the top row and clicked the center text icon ( ) to center the terms of 

service titles. 

After formatting the text font, style, size and colors, the table now looks like this: 

 

I want to center [[PictureGallery]] horizontally in the wrapper, but Kompozer applies HTML code to center 

the text, not the gallery itself, so I have to put that into a small one-cell table to center the gallery. To do 

so, below the main table, click your Enter key to get to a new line, then insert a one-celled table with these 

attributes: 
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Type [[PictureGallery]] into this table. Click and drag your mouse from right after the main table to below 

the Picture Gallery table and right-click to Cut. Highlight [[PictureGallery]] below [[Description]] and paste 

the Picture Gallery table. If you’ve created extra spacing, delete it. 

The last thing I want to do is add my logo below the yellow table. Click on the Image icon ( ) and put 

the URL of your logo (must be online, such as in photobucket or your website). Put the alternate text to 

identify your logo: 

 

If your logo is too large for the space as mine was, click and drag one of the corners to make it smaller: 
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This is what the wrapper now looks like in Kompozer: 

 

It’s now ready to go, so Save this in Kompozer and Exit. 

When you do a preview thru the “Check Item” button in the SixBit Item Window, you’ll see this (with your 

own pictures): 
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The yellow table shows to the left in the SixBit preview and you don’t see the top and left borders, but  all 

is correct when submitted on eBay: 

 

 

FREE DESCRIPTION WRAPPERS 

You can google free eBay listing templates, or find some designed by fellow eBayers at these locations: 

http://www.isdntek.com/demo/spring/templates.htm 

http://www.isdntek.com/demo/fall/templates.htm 

http://www.isdntek.com/demo/holiday/templates.htm 

http://www.going1nce.com/freetemplates.html (ones I made up years ago) 

Here are instructions on using one of my free templates as a description wrapper in SixBit through 

Kompozer: 

Go to the template page from http://www.going1nce.com/freetemplates.html. In this sample, I use 

http://www.going1nce.com/freetemplates/template-purpgold.html. If using Firefox or Internet Explorer, 

right-click on a blank part of that page to “View Source”. In Chrome, right-click to “View Page Source”.  



50 
 

Select all of the source code and copy it. 

In SixBit, under the little orange guy, go to Manage> Description Wrappers. Click the New button and name 

your wrapper such as in the image to the right. Click OK. 

Select your Wrapper in the list on the left side of the “Manage Description Wrappers” window and click the 

Edit button to open Kompozer. Kompozer opens to “Normal”, which is the WYSIWYG window. Click on the 

Source tab ( ) and paste the code into that, then click back to the Normal tab ( ). 

You may format any of the text by highlighting it and choosing your formatting under the Format menu. If 

you want to use one of your item pictures, replace [[Pictures]] with [[Picture1]]. If you want to add 

additional pictures in this wrapper, click Enter after [[Picture1]] and type in [[Picture2]]. Repeat this step to 

add tags for pictures 3 – 12. (If you use this template with 12 picture tags but only have 3 pictures, SixBit 

will ignore all the extra tags.) 

On this wrapper, you see some filler text below the graphics for payments, shipping and returns. Replace 

that text with your own information. If you want to add your logo below the terms, put your cursor before 

“Template by…” and click Enter. Place your cursor on the newly empty line above “Template by…” 

Click on the Image icon ( ) and put the URL of your logo (must be online, such as in photobucket or your 

website). Put the alternate text to identify your logo: 

 

If your logo is too large for the space as mine was, click and drag one of the corners to make it smaller: 
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This is what this wrapper now looks like in the Kompozer Preview: 

 

It’s now ready to go, so Save this in Kompozer and Exit. 

In SixBit, the preview may look like this: 

 

When uploaded to eBay, it should look like this: 

 

Before using a wrapper in SixBit which doesn’t preview as expected, such as the above, create a test listing 

in the Everything Else>Test Auctions>General category with a title and description of “Test Listing” and a 

fixed price of $25 or so (so people won’t dare bid) to make sure it displays correctly on eBay. 
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FIELDS TO USE IN DESCRIPTIONS & WRAPPERS 

You may insert variable tags into your description and wrapper to display the content from those fields. 

Below is a list of the SixBit fields which may be used. You may also insert Item Specifics similarly. For 

example, one of the SixBit fields, Condition Description, can be inserted as [[ConditionDescription]]. An 

eBay Item specific such as Style could be inserted as [[Style]], or your own Private Item Specific (which is 

essentially a custom field) such as Artist Name, can be inserted as [[Artist Name]]. You may also insert 

“Snippets” (as described below) in the same manner. 

[[BusinessName]] 

[[BuyItNowPrice]] 

[[ConditionDescription]] 

[[Description]] 

[[DispatchTimeMax]] 

[[FixedPrice]] 

[[Folder]] 

[[IntHandlingFee]] 

[[IntShippingService1]] 

[[IntShippingService2]] 

[[IntShippingService3]] 

[[IntShippingService4]] 

[[IntShippingService5]] 

[[IntShippingServiceAdditionalC

ost1]] 

[[IntShippingServiceAdditionalC

ost2]] 

[[IntShippingServiceAdditionalC

ost3]] 

[[IntShippingServiceAdditionalC

ost3]] 

[[IntShippingServiceAdditionalC

ost4]] 

[[IntShippingServiceAdditionalC

ost5]] 

[[IntShippingServiceCost1]] 

[[IntShippingServiceCost2]] 

[[IntShippingServiceCost3]] 

[[IntShippingServiceCost4]] 

[[IntShippingServiceCost5]] 

[[ItemID]] 
 

[[LotSize]] 

[[MSRP]] 

[[PackageDepth]] 

[[PackageLength]] 

[[PackageWidth]] 

[[PaymentInstructio

ns]] 

[[PayPalEmail]] 

[[Picture1]] 

[[Picture10]] 

[[Picture11]] 

[[Picture12]] 

[[Picture2]] 

[[Picture3]] 

[[Picture4]] 

[[Picture5]] 

[[Picture6]] 

[[Picture7]] 

[[Picture8]] 

[[Picture9]] 

[[PictureGallery]] 

[[PictureURL1]] 

[[PictureURL10]] 

[[PictureURL11]] 

[[PictureURL12]] 

[[PictureURL2]] 
 

[[PictureURL3]] 

[[PictureURL4]] 

[[PictureURL5]] 

[[PictureURL6]] 

[[PictureURL7]] 

[[PictureURL8]] 

[[PictureURL9]] 

[[ProductID]] 

[[ProductTitle]] 

[[QtyToList]] 

[[RefundPolicy]] 

[[ReservePrice]] 

[[RestockingFee]] 

[[ReturnPaidBy]] 

[[ReturnPolicy]] 

[[ReturnWithin]] 

[[SellerAccountEbay

]] 

[[SellerCountry]] 

[[SellerLocation]] 

[[SellerPostalCode]] 

[[SellerReturnAddre

ss]] 

[[ShippingService1]] 

[[ShippingService2]] 

[[ShippingService3]] 
 

[[ShippingService4]] 

[[ShippingServiceAdditionalCo

st1]] 

[[ShippingServiceAdditionalCo

st2]] 

[[ShippingServiceAdditionalCo

st3]] 

[[ShippingServiceAdditionalCo

st4]] 

[[ShippingServiceCost1]] 

[[ShippingServiceCost2]] 

[[ShippingServiceCost3]] 

[[ShippingServiceCost4]] 

[[SiteName]] 

[[SKU]] 

[[StartingPrice]] 

[[StorageLocation]] 

[[SubTitle]] 

[[Surcharge1]] 

[[Surcharge2]] 

[[Surcharge3]] 

[[Surcharge4]] 

[[Title]] 

[[VATPercent]] 

[[WeightMajor]] 

[[WeightMinor]] 
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SNIPPETS 

Snippets are similar to variable tags as described in the above paragraph, but they hold text (and HTML) you 

create. A common Snippet may be your Returns Policy. You could then insert [[Returns Policy]] into your 

description wrapper. If later you have to change a bit on that policy, edit the Snippet and revise items and 

listings as needed to update with the new policy. 

You may only add, edit and delete snippets while you have the default HTML editor selected in Options as 

described on page 5, “Creating Items”. See “adding snippets” in the SixBit User Guide for more info on 

Snippets. 

RETRIEVE OLD PHOTOS FROM SIXBIT DATABASE 

Perhaps you list an item in SixBit tomorrow and you’ve uploaded the item photos to eBay then deleted those 

photos from your computer. The item goes unsold, but 4 months from now someone finds your listing 

somehow and contacts you to see if the item is still available and asks for photos because eBay no longer 

shows them. If you’ve not deleted the photos from the SixBit database, you can retrieve them back to your 

computer by the following process. 

Select the item record in SixBit, click on the little orange guy and go to Export>Export to flat file. Choose to 

export just the selected file(s). Next to the “Export to” field, browse to where you want to save the CSV file 

and name it, then click OK. The Export to CSV window opens. This is a chopped up image of that window: 

 

1. Check the box “When exporting…” 

2. Click on Pictures and 

3. Drag to the Mapping Source 

4. Select Export Path 

5. Select the folder (or create a new one) you want the photos put into 

6. Click OK 

7. Click OK 

Then, go to that folder and you’ll see any pictures you’ve exported. 
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ADVERTISEMENT 

       

Thought you’d get away, eh? Nope – I’m moved to advertise my services! 

I do remote one-on-one (or one-on-a few) training and consultation on SixBit. As I write this, I’ve trained 

about a dozen SixBit newbies on its use (and dozens of Blackthorne users previously on that software). I also 

design Description Wrappers (Listing templates), eBay stores, logos and other web and “real world” 

graphics. (See some of my eBay design at http://stores.ebay.com/MiloDesign/Portfolio.html.)  Please keep 

me in mind should you need such services or know of someone who does. 

If you’ve not yet subscribed to SixBit or recommend it to another seller, please use my affiliate link to sign 

up: ww.sixbitsoftware.com/clients/aff.php?aff=016. (I will receive a small royalty from SixBit from those 

who subscribe from that link.) 

Thanks! 

 

Sally Milo – MiloDesign on eBay – http://stores.ebay.com/MiloDesign 


